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Warranty and Liability

Note The Application Examples are not binding and do not claim to be complete
regarding the circuits shown, equipping and any eventuality. The Application
Examples do not represent customer-specific solutions. They are only intended
to provide support for typical applications. You are responsible for ensuring that
the described products are used correctly. These Application Examples do not
relieve you of the responsibility to use sound practices in application, installation,
operation and maintenance. When using these Application Examples, you
recognize that we cannot be made liable for any damage/claims beyond the
liability clause described. We reserve the right to make changes to these
Application Examples at any time without prior notice. If there are any deviations
between the recommendations provided in these Application Examples and
other Siemens publications — e.g. Catalogs — the contents of the other
documents have priority.

We do not accept any liability for the information contained in this document.

Any claims against us — based on whatever legal reason — resulting from the use of
the examples, information, programs, engineering and performance data etc.,
described in this Application Example shall be excluded. Such an exclusion shall
not apply in the case of mandatory liability, e.g. under the German Product Liability
Act ("Produkthaftungsgesetz"), in case of intent, gross negligence, or injury of life,
body or health, guarantee for the quality of a product, fraudulent concealment of a
deficiency or breach of a condition which goes to the root of the contract
("wesentliche Vertragspflichten"). The damages for a breach of a substantial
contractual obligation are, however, limited to the foreseeable damage, typical for
the type of contract, except in the event of intent or gross negligence or injury to
life, body or health. The above provisions do not imply a change of the burden of
proof to your detriment.

Any form of duplication or distribution of these Application Examples or excerpts
hereof is prohibited without the expressed consent of Siemens Industry Sector.

Important

This document contains information on registry editing. We recommend creating a
safety copy of the registry before editing it. For further information on how to create
a safety copy, restore and edit the registry, please refer to the Microsoft Knowledge
Base article no. 256986. Incorrect use of the Registry Editor might cause serious
problems affecting the entire system and requiring new installation. Use the
Registry Editor on your own responsibility.

Caution

The functions and solutions described in this entry predominantly confine
themselves to the realization of the automation task. Please also take into account
that corresponding protective measures have to be taken in the context of
Industrial Security when connecting your equipment to other parts of the plant, the
enterprise network or the Internet. For more information, please refer to entry ID
50203404.

http://support.automation.siemens.com/\WWW/view/en/50203404
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1 Library Overview

1.1 User scenario

1 Library Overview

What you get

This document describes the "S7_CPU_SNTPServer" block library. This block
library includes a tested code with well-defined interfaces. You can use these as
basis for your projected task.

A key concern of the document is to describe
e all blocks pertaining to the block library,
e the functionalities provided by these blocks.

Furthermore, this documentation shows possible fields of application and helps you
integrate the library into your STEP 7 project using step-by-step instructions.

S7_CPU_SNTPServer
Entry ID: 82203451, V1.0, 10/2013 4
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1 Library Overview

1.1 User scenario

1.1

User scenario

Introduction

The PROFINET CPUs of the S7-300, S7-400, WinAC RTX, S7-1200, and S7-1500
series can be configured as NTP clients for time synchronization as a standard
feature. With regard to the firmware, the S7 CPUs are generally not designated as
NTP servers. For time synchronization in an automation cell, a suitable timer
system such as SICLOCK or - for synchronization using the SIMATIC process -
additional hardware (communication processors) has to be used.

Possible application of the "S7_CPU_SNTPServer" library

Scenario

For automation cells or plant sections, the use of the exact International Atomic
Time (TAl) is often secondary. It is usually sufficient to have a common time base
for all automation components.

Using an S7 CPU as SNTP server allows for flexible and simple synchronization of
plants and plant sections, for example, to receive meaningful time stamps for error
messages and logs plant-wide.

The following figure shows a possible sample configuration with an S7-1200 CPU
as SNTP server. Here, the S7 CPU as SNTP server receives the time via a
SIPLUS DCF77 module (for the coupling of the DCF77 module to S7-1200, please
refer to \11\). However, any other configuration with a different timer is also
possible.

Figure 1-1

Comfort Panel

(NTP Client) S7-1500
= (NTP Client)
|
o
C 3
LU

. PROFINET / IE
SIPLUS DCF 77 S§7-1200
Radio Clock Module (SNTP Server)
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1 Library Overview

1.2 Hardware and software requirements

Function
The library provides a function block that accomplishes the following functions:
e Receipt and analysis of an NTP message from an SNTP client.
e Creation and sending of an SNTP message to the client for time
synchronization.
1.2 Hardware and software requirements

Requirements for this library

The following hardware and software requirements must be met in order to use the
functionality of the library described in this document:

Hardware
The "S7_CPU_SNTPServer" library can be used with all PROFINET S7 CPUs with
which Open User Communication (OUC) can be programmed.
This can be CPUs of the following series:
e S7-300 CPUs
e S7-400 CPUs
e S7-1200 CPUs
e S7-1500 CPUs
e WinAC RTX
Software
Table 1-1
Component Order number
SIMATIC STEP 7 V5.5 SP3 6ES77810-4CC10-0YAS
SIMATIC STEP 7 PROFESSIONAL V12 SP1 6ES7822-1AA02-0YAS

S7_CPU_SNTPServer
Entry ID: 82203451, V1.0, 10/2013 6
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1 Library Overview

1.3 Library resources

1.3 Library resources

What will you learn here?

The overview below shows the main memory occupancy of the
"S7_CPU_SNTPServer" library's block.

Total occupancy

The block pertaining to the "S7_CPU_SNTPServer" library occupies 4776 bytes of
the main memory at the maximum (S7-300/S7-400) and 33472 kbytes of the load
memory at the maximum (S7-1200/S7-1500).

Occupancy of the individual blocks
Library for S7-300 CPU (including called system blocks)

Table 1-2
Symbolic name Load memory (bytes) Main memory (bytes)
SNTP_Serv 2552 2046
DT_DATE 546 448
DT_TOD 312 242
EQ_DT 194 134
TCON 1234 1018
TURCV 584 472
TUSEND 526 416

Library for S7-1500 CPU
Table 1-3

Symbolic name

Load memory (bytes)

Main memory (bytes)

SNTP_Serv

33472

2289

S7_CPU_SNTPServer
Entry ID: 82203451, V1.0, 10/2013
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2 Preconditions for Time Synchronization

2.1 System time (UTC) and local time

2 Preconditions for Time Synchronization

What will you learn here?
This chapter briefly outlines the theoretical basics of time synchronization.

21 System time (UTC) and local time

Explanation of terms

Based on the Universal Time Coordinated (UTC), the local time is determined
starting from the prime meridian, taking into account the time shift and
summer/winter times, if applicable.

The Central European Time (CET) is calculated as UTC plus one hour. In the
summer, the Central European Summer Time (CEST) applies, which is calculated
as UTC plus two hours.

The NTP and SNTP protocols always send the UTC according to specification. If
the local time is to be kept, corresponding settings or calculations are required.

S$7-1500 and S7-1200

S7-1500 and S7-1200 CPUs include a system time as well as a local time.

When the time of these CPUs is synchronized via an NTP/SNTP server, the UTC is
applied as system time and the local time is calculated automatically, based on the
settings made (also see chapter 5.2).

S$7-300 and S7-400

S7-300 and S7-400 CPUs include only a system time which is set to the UTC
during synchronization via the CPU using an NTP/SNTP server.

To have also the local time available, for example, for the generation of messages,
the local time has to be calculated using system-internal functions (refer to

section 5.3 and the Siemens Online Support \1\ which contains many articles on
the subject of time synchronization).

S7_CPU_SNTPServer
Entry ID: 82203451, V1.0, 10/2013 8
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2 Preconditions for Time Synchronization

2.2 Time synchronization protocol

2.2 Time synchronization protocol
221 Network Time Protocol (NTP)
Task

NTP serves for the synchronization of clocks in a network. PCs, panels, controls,
etc. can synchronize time via a (or several) server(s).

Function principle

An NTP client sends a message which is already assigned time stamps to the NTP
server. The server responds to this message (by using an algorithm, for example,
to consider packet runtimes) and the client then sets its clock according to the
information received in the message.

An NTP client can have several time servers entered. Based on the "stratum"
entered in the message and other factors, the client decides in favor of the optimal
server and sends the request message to it.

222 Simple Network Time Protocol (SNTP)

Differentiation between NTP and SNTP

SNTP is a simplified form of the NTP. Due to the simpler algorithms used, the
SNTP is less accurate than the NTP. However, for the use in automation cells, the
accuracy of the SNTP time synchronization is usually absolutely sufficient.

The structure of the messages is identical in both protocols, which means that NTP
clients can also obtain the time from SNTP servers.

S7_CPU_SNTPServer
Entry ID: 82203451, V1.0, 10/2013 9
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2 Preconditions for Time Synchronization

2.3 Open User Communication
Figure 2-1 Structure of the NTP/SNTP message
1 2 3
012345678%012345678%90123456789 0

1

Fot—t—t—t—F—t—t—F—t—F—t—t—t—Ft—F—t—F—F—F—F—F—F—t—F—F—F—F—F+—F—+—+—+

|LI | VN |Mode | Stratum | Poll | Precision

Fot—t—t—t—F—t—t—F—t—F—t—t—t—Ft—F—t—F—F—F—F—F—F—t—F—F—F—F—F+—F—+—+—+

Root Delay
Root Dispersion

Reference Identifier

Reference Timestamp (64)

Originate Timestamp (64)

Receive Timestamp (64)

Transmit Timestamp (64)

—t—t—t—t—t—+t—F—t—F—F—t—Ft—t—F—t—F—F—+—+—+—+—
Key Identifier (optional)
—t—t—t—t—t—+t—F—t—F—F—t—Ft—t—F—t—F—F—+—+—+—+—

+ o~ +
o)
+ a4

Message Digest (optional) (128)

o — o — — — o — o —

For a detailed description of the SNTP, please refer to \4\.

Using SNTP

Since its implementation is easy and its accuracy is sufficient for automation
technology, the SNTP is used by the "S7_CPU_SNTPServer" library.

2.3 Open User Communication

The basis of the SNTP is UDP, which is implemented with the help of Open User
Communication (OUC) in the PROFINET CPUs.

S7_CPU_SNTPServer
Entry ID: 82203451, V1.0, 10/2013
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3 Blocks of the Library

3.1 Block list

3 Blocks of the Library
3.1 Block list

The "S7_CPU_SNTPServer" library consists of the "SNTP_Serv" block and the
system functions called therein.

In STEP 7 V5.5, these have to be inserted separately into the user program; in
STEP 7 > V12, they are inserted automatically during function block compilation.

3.2 Explanation of the blocks

What will you learn here?

This section describes the function principle of the SNTP_Serv FB (FB 1000) as
well as the calling and formal parameters of the function block for S7-300/S7-
400/Win AC RTX and S7-1200/S7-1500.

3.21 Statuses of the SNTP_Serv FB (FB1000)

Internally, the SNTP_SERYV FB (FB 1000) works as a simple state machine which

is processed after an initialization.

The following figure schematically shows the successful processing of the
SNTP_SERV FB (FB1000).

Figure 3-1

Parameters

a initialized
Initialize parameters;
set state = 0

Initialize
UDP connection

%,
%%

Connection
initialized

Create SNTP 9 m,
message and send €ssg
; 8e g,
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Receive 6

NTP message from
NTP client

Wait for
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Message
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3 Blocks of the Library

3.2 Explanation of the blocks

The following table describes an error-free time synchronization:

Table 3-1

No.

Action

1. The FB is called with Startup = TRUE for one cycle and the parameters of the FB
are initialized.

The local communication access point is set up at port 123 (TCON instruction).

3. The request message from an NTP client is awaited (TURCV instruction).

When the time request from an NTP client has been detected, the response
message is created and then sent to the client (TUSEND).

5. Afterwards, a new request message is awaited again (from the same or a
different client; -> status 3).

From any status it can be returned to the initialization status with another change of
edge at the Startup = TRUE input.

3.21 Calling and parameters of the SNTP_SERV FB (FB1000) for

S$7-1500/S7-1200

The following figure shows the call interface of the SNTP_SERV FB (FB1000). The
table describes the parameters of the function block.

%FB1000
"SNTP_Serv"
— N
... = Startup
Referenceldenti TCON_ERR
fier TURCV_ERR
LastTimeSet TUSEND_ERR
OUC_Con_ID ENO —
Table 3-2
Parameter Type Remark
Startup IN: Upon CPU startup, the Startup parameter has to
Bool be supplied with "TRUE" for one cycle.
After a positive edge at "Startup”, all parameters
of the SNTP_SERV FB are initialized.
Referenceldentifier | IN: The Referenceldentifier input specifies from
USint which time source the server CPU obtains the

time:
e  0:uncalibrated (set "manually")
e 1:primary reference (e.g., DCF 77)

e 2:secondary reference (e.g., from GPS
receiver)

The information is forwarded to the NTP client in
the SNTP protocol.

S7_CPU_SNTPServer
Entry ID: 82203451, V1.0, 10/2013
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3 Blocks of the Library

3.2 Explanation of the blocks

Parameter Type Remark
LastTimeSet IN: If the information when the time was set last is
DTL available, this information is connected to the
"LastTimeSet" input.
This information is forwarded to the NTP client
in the SNTP protocol.
OUC_Con_ID IN: Is assigned with a free connection ID.
CONN_OUC The parameter is used internally by the T blocks
for connection establishment, among other
things.
ERROR OUT: ERROR = TRUE as long as an error is pending
Bool in the block.
STATUS OUT: Specifies the error signaled by ERROR =
DWord TRUE.
See Table 3-3.

The table below shows the meaning of the "STATUS" output parameter.
Table 3-3 STATUS output parameter

Byte 2-3 Byte 0-1 Meaning
16#xxx1 16#XXXX An error has occurred at the TCON instruction.
Bytes 0-1 contain the status of the instruction.
16#xxx2 16#XXXX An error has occurred at the TUSEND instruction.
Bytes 0-1 contain the status of the instruction.
16#xxx3 16#XXXX An error has occurred at the TURCYV instruction.

Bytes 0-1 contain the status of the instruction.

Interconnect the output parameters in order to recognize an error of the block
and for adequate error handling.

S7_CPU_SNTPServer
Entry ID: 82203451, V1.0, 10/2013
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3 Blocks of the Library

3.2 Explanation of the blocks

3.2.2

S$7-300/S7-400

Calling and parameters of the SNTP_SERV FB (FB1000) for

The following figure shows the call interface of the SNTP_SERV FB (FB1000). The
table describes the parameters of the function block.

%FB1000
"SNTP_Senv

... EN
- = Startup

Referenceldenti
fier

LastTimeSet ERROR =— ---
OUC_Con_ID STATUS
LocDeviD ENO —
Table 3-4
Parameter Type Remark
Startup IN: Upon CPU startup, the Startup parameter has to

Bool be supplied with "TRUE" for one cycle.

After a positive edge at "Startup”, all parameters
of the SNTP_SERV FB are initialized.
Referenceldentifier | IN: The Referenceldentifier input specifies from
Byte which time source the server CPU obtains the
time:
e 0:uncalibrated (set "manually")
e 1: primary reference (e.g., DCF 77)
e 2:secondary reference (e.g., from GPS
receiver)
The information is forwarded to the NTP client in
the SNTP protocol.
LastTimeSet IN: If the information when the time was set last is
Date and Time | available, this information is connected to the
- "LastTimeSet" input.
This information is forwarded to the NTP client
in the SNTP protocol.
OUC_Con_ID IN: Is assigned with a free connection ID.

Word The parameter is used internally by the T blocks
for connection establishment, among other
things.

LocDevID IN: Specifies the device ID. For more detailed

Byte information, please refer to the STEP 7 Online

Help or the FAQ with the entry ID 51339682.
ERROR OUT: ERROR = TRUE as long as an error is pending

Bool in the block.

STATUS OUT: Specifies the error signaled by ERROR =

DWord TRUE.

See Table 3-5.

The table below shows the meaning of the "STATUS" output parameter.

S7_CPU_SNTPServer

Entry ID: 82203451,

V1.0, 10/2013
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3 Blocks of the Library

3.2 Explanation of the blocks

Table 3-5 STATUS output parameter

Byte 2-3 Byte 0-1 Meaning

16#8xxx 16HXXXX The "LocDevID" input parameter is connected to
an unaccepted value.

16#xxx1 16#xxxX An error has occurred at the TCON instruction.
Bytes 0-1 contain the status of the instruction.

16#xxx2 16#xxXX An error has occurred at the TUSEND instruction.
Bytes 0-1 contain the status of the instruction.

16#xxx3 16#xxxXX An error has occurred at the TURCV instruction.
Bytes 0-1 contain the status of the instruction.

Note Interconnect the output parameters in order to recognize an error of the block

and for adequate error handling.

S7_CPU_SNTPServer
Entry ID: 82203451, V1.0, 10/2013
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4 Working with the Library

4.1 Integrating the library into STEP 7 V5.5

4 Working with the Library

What will you learn here?

In order that the previously described library functions can be used, they must first
be integrated into the configuration software. The necessary steps are listed in the
following sections.

4.1 Integrating the library into STEP 7 V5.5

Table 4-1
Step Instruction
1. The library is available on the HTML page from which you downloaded this
document. Save the "S7_CPU_SNTPServer"library on your hard disk.
2. Open the SIMATIC MANAGER and unzip the "S7_CPU_SNTPServer" STEP 7
library.
"File > Retrieve..."
3. From now on, the library is available under "Libraries".
Open Project @
User projects  Libraries l Sample prniects] Multiproiects]
I arne | Storage path -
@ CF PP C:A\Program Files [#8E])\SiemenzhStep s
@2 Redundant 10 CGP Y40 C:\Pragram Files [<86)sSismensiStep?
@Hedundant |0 CGP VB2 C:\Program Files [#BE])\Siemens\Step?' =
C:A\Program Files [«88)4SiemenshStep .
@S?_EF'U_SNTF'Sewer C:dzers\OnlineSupporthDesktophesch,
SIMATIC_MET_CP C:\Program Files [#86])\SiemenshStep .
& Standard Library C:\Program Files [#86]%Siemenz\Step?s! _
T - — - p— C e = - _P
Selected
Open an already existing STEP 7 V5.5 project.
5. Open the library.
&2 S7_CPU_SMTPServer -- C:\Use
=g 57_CPU_SNTPServer
=-{z2] 57-Programm(1]

S7_CPU_SNTPServer
Entry ID: 82203451, V1.0, 10/2013 16
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4 Working with the Library

4.1 Integrating the library into STEP 7 V5.5

Step

6.

Instruction
Select the S7 program of the library and insert it into your STEP 7 project using
drag & drop.
% Im15185NTPServ -- C:hUsers\OnlineSupport\Document; & S7_CPU_SNTPServer -- C:\Users\O S7_CPU_SNTP?
E@ In15185NT PServ Object name B4 57_CPU_SNTPServer Ohject name $ymbolic name
- Im151-8PN 9 Systemdaten =57 ST-Progiamm(1]
= [l MIST8PN/DP CPU | 0y {0 Duelen
E-E0 §7Frogamm1) |5 gproo g3 Bausteine
@ Qual\er.v o s
~{gH Bausteine 23 Fee7
&3 FEES
£ FB1000 g |

S FCa
£ DB1000

43 UDTES

< I | »

4 m |

&3 FCE i
e &

Now you can use the blocks of the library in your user program. The other blocks
apart from the SNTP_SERYV FB (FB1000) are function blocks used by this block.

Section 4.4 describes how to set up an S7 CPU as SNTP server in STEP 7 V12.
Setup in STEP 7 V5.5 is done analogously.

S7_CPU_SNTPServer

Entry ID: 82203451, V1.0,

10/2013
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4 Working with the Library

4.2 Integrating the library into STEP 7 V12

4.2 Integrating the library into STEP 7 V12

In order that the previously described functions of the SMS_S7_1500 (FB18) can
be used, it is necessary to integrate the library into the configuration software first.
The necessary steps are listed in the following table.

Table 4-2

No.

Instruction

The library is available on the HTML page from which you downloaded this
document (\1\). Save the S7_CPU_SNTPServer_V12.ziplibrary on your hard
disk.

Unzip the library.

Open your already existing STEP 7 V12 project.

In the "Global Libraries" palette, click on "Open global library" in the toolbar or
select "Global libraries > open library..." in the "Options" menu.

v | Global libraries
(L3 EIH& u 55 & [ [~]
b [l | Buttons-and-Switches

b Ll Long Functions
* Ll Monitoring-and-control-chjects

o
]

b Ll Documentation templates

The "Open global library" dialog box opens.

Select the global library 'S7_CPU_SNTPServer.al12".
 AdditionalFiles
oI
| Systern
. TMP
. UserFiles
T 57_CPU_SNTPServer

Depending on the CPU used, drag and drop the blocks from the "Master copies >
300/400" or "Master copies > 1200/1500" folder to the Program blocks" folder of
your device.

- [356.57.1500 & ET3E
. = 2 - -
;Md new device Qs‘zi’ A4 ‘ Global libraries
Devices & networks =T =
= -
~ [ PLC_1 [CPU 1516-3 PN/DP] , & W

» L] Buttons-and-Switches

» [11Long Functions

4 » LLI Monitering-and-control-objects
» [l Documentation templates

~ [L]SMS_S7_1500_Library

[IY Device configuration
% Online & diagnostics

I * |- Program blocks i‘—" o
» L4 Technology objects |0

» @ External source files

b @ PLCtags
b (g PLC data types IMaster copies

¥ [E Watch and force ables B RERECRGN
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4 Working with the Library

4.3 Setting up an S7-1500/S7-1200 CPU as SNTP server

4.3 Setting up an S7-1500/S7-1200 CPU as SNTP server

The following table describes the procedure for setting up an S7-1500/S7-1200
CPU as SNTP server.

Table 4-3
No. Instruction

1. Create a data block for interconnecting the input and output parameters of the
SNTP_SERV FB (FB 1000) with the variables shown in the screenshot.
- Startup Bool
L] Referenceldentifier Usint
= » LastTimeSet DTL
] OUC_Con_ID CONN_OUC
a TCOM_ERR Word
a TURCY_ERR Word
] TUSEND_ERR Word

2. Insert the SNTP_SERV FB (FB1000) into OB1 and interconnect the input and

output parameters with the parameters of the same name of the data block
created in step 1. For help, please refer to section 3.2.1.

Adapt the input parameters according to your application (for example, the
connection ID "OUC_Con_ID" must not yet be used in the project).

3. Insert a startup OB (OB100) into your project and in this OB reset the "Startup”
variable of the block created in step 1.

>=1
%M1.0 "Param_DB".
"Tag_5"—0 Startup
%M1.0 =
"Tag_5" =3¢ — —
4, Insert a new network into OB1 and there reset the "Startup” variable of the block
created in step 1.
&
%M1.0 "Param_DB".
"Tag_5"—0 Startup
%M1.0 =
"Tag_5" = 3¢ — —
5. Load your user program to the CPU and restart the CPU. The CPU then works

as SNTP server.

Online |Options  Tocls Window Help

ﬂ Go anline Crrl+K
;jrq 20 offline Ctrl+m
Simulation ]
m Download to device Ctrl+L

Extended download to device...

IDownload and reset FLC %l

S7_CPU_SNTPServer
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4.4 Setting up an S7-400/S7-300 CPU as SNTP server

4.4 Setting up an S7-400/S7-300 CPU as SNTP server

The following table describes the procedure for setting up an S7-400/S7-300 CPU
as SNTP server.

Table 4-4
No. Instruction
1. Create a data block for interconnecting the input and output parameters of the
SNTP_SERV FB (FB 1000) with the variables shown in the screenshot.

Startup Bool
Referenceldentifier Byte
LastTimesSet Date_And_Time
QUC_Con_ID Word
LacDeviD Byte
TCON_ERR Word
TURCV_ERR Word
TUSEND_ERR Word
STATUS Word

2. Insert the SNTP_SERV FB (FB1000) into OB1 and interconnect the input and

output parameters with the parameters of the same name of the data block
created in step 1.

Adapt the input parameters according to your application. For help, please refer
to section 3.2.2.

e OUC_Con_ID: ID not yet occupied by another connection.
e LocDevID: ID of the interface of your CPU. Please refer to the STEP 7 online

help.
3. Insert a startup OB (OB100) into your project and in this OB reset the "Startup”
variable of the block created in step 1.
>=1
%M1.0 "Param_DB".
"Tag_5"—0 Startup
%M1.0 =
"Tag_5"=— 3¢ — —
4, Insert a new network into OB1 and there reset the "Startup” variable of the block
created in step 1.
&
%M1.0 "Param_DB".
"Tag_5"—0 Startup
%M1.0 =
"Tag_5" = 3§ — —
5. Load your user program to the CPU and restart the CPU. The CPU then works

as SNTP server.

Online |Options Tools Window Help

& Goonline Crrl+k
£¥ Go offline Carl+hd
Simulation »
[E Download to device Ctrl+L

Extended download to device...
IDDwnlnad and reset FLC program |

S7_CPU_SNTPServer
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5.1 Timer

5 Notes and Support
5.1 Timer

In order to set the time of the SNTP server you can exercise one of the following
options:

e Setting the CPU clock to the time of the connected PG (with the help of
STEP 7). See Table 5-1.

e Using the SIPLUS DCF 77 radio clock module. For information on how to use
the radio clock module, please refer to \6\ and \11\.

¢ Reading out the time of a commercially available GPS receiver. For information
on that, please refer to the FAQ with the entry ID 42087405.

Table 5-1 Setting the time of an S7-1500 CPU with the help of STEP 7 V12

No. Instruction

1. In your project tree, double-click on "Online access >
[YOUR_NETWORK_DEVICE] > Update accessible devices".

~ 1@ Online access
» [ use [s7UsE]
» [}l COM[RS232/PFI multi-master cable]
» :u COM <2 [R5232/FFI multi-maszter cable]
- :ﬂ Intel(R} PROI1000 MT Metwork Connection

L 3Update n({si)lz devices:

2. Select the CPU for which you want to set the time and click on "Online &
diagnostics".
~ [l PLC_3[192.168.0.2]

» :g Online card data

3. In the editor section, click on "Functions > Set time". Check the "Take from
PG/PC" box and then click on "Apply".
T F“ Module time
Assign IP address [october 15 2013 [-] [oo:22:15 7]

Reset to factory settings
Format memory card [ Take from PGIPC Apply

Assign name

Now the time of the PG/PC is applied by the S7 CPU.

S7_CPU_SNTPServer
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5 Notes and Support

5.2 Setting up an S7-1500/S7-1200 as NTP client

5.2 Setting up an S7-1500/S7-1200 as NTP client

Hardware configuration settings (HWCN)

The following table describes how to set up the CPU as NTP client.

Table 5-2

No.

Instruction

In the project navigation, select "[YOUR_PROJECT] > [YOUR_CPU] > device
configuration" and in the inspector window click on the "Properties" tab.

Select the PROFINET interface of the CPU and click on "Time synchronization"
(o )- Check the "Enable time synchronization via NTP server" box (9) and
confirm the prompt. Then enter the IP address of the server CPU (9) and the
required update interval (0)_

» General
Time synchronization
w FROFINET interface [X1] Y
General NTP mode

Etherneta ddres;o

Operating mode

[ Enable time synchronimtion via NTF server

IPaddresses

Serverl: | 192 _ 168 _ 0 29

» Advanced options

Web serveraccess

Hardware identifier Server2: |0 .0 .0 .0
» PROFINETinterface [X2] Sserver3: | O .0 -0 -0
} DPinterface [X3] serverd: [0 .o .0 .0
Startup o
Update interval: |86400 s |

Cycle

Then go to the entry "Time of day" (o) and adjust the time zone (9) and the
difference between standard and daylight savings time (9)_

b General Ti £ d
~ PROFINET interface [X1] ime of day
General Local time

Ethernet addresses

Time synchroniztion Time mne: | (UTC +01:00) Amsterdam, Berlin, Bern, Rome, Sto| »

Operating mode

-

Advanced options Daylight savings
Web server access
Hardware identifier

PROFINET interface [%2]

[V Enable daylight savings time changeover

-

Difference between standard

b DPinterface [X3] and daylight savings time- |60 mins [ %] e
Startup . . .
Cyele Start of daylight saving time
Comrnunication load
|Last |v|
System and clock memary
» System diagnostics ml [Sunday [~]
b Web server [ of: |I'\-1arch |V|
Display M | |

at | 02:00a.m.

User interfaangua ges

Frotection

Start of standard time

-

System power supply

S7_CPU_SNTPServer
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5 Notes and Support

5.2 Setting up an S7-1500/S7-1200 as NTP client

Differentiation: system time and local time

The system time of the CPU is the internal time of the CPU, in this case transferred
by the NTP protocol. It is usually provided as UTC.

The local time is the time of the location of the CPU (time zone, summer/winter
time) calculated dependent on the system time.

Reading out the system time

The system time can be read out with the instruction RD_SYS_T. The output
parameter 'RET_VAL' of the instruction corresponds to '0'" if read-out is completed
successfully.

The time is written to a variable via the 'OUT' output parameter with one of the
following data types:

e DT
e LDT
e DTL

Reading out the local time

The local time of the CPU can be read out with the instruction RD_LOC_T. The
output parameter 'RET_VAL' of the instruction corresponds to '0' if read-out was
successful. It corresponds to '1' if read-out was successful and the local time is

currently set to daylight savings time.

The time is written to a variable via the 'OUT' output parameter with one of the
following data types:

e DT
e LDT
e DTL

S7_CPU_SNTPServer
Entry ID: 82203451, V1.0, 10/2013 23



5 Notes and Support

Copyright © Siemens AG 2013 All rights reserved

5.3 Setting up an S7-300/S7-400 as NTP client

5.3 Setting up an S7-300/S7-400 as NTP client

Hardware configuration settings (HWCN)
The following table describes how to set up the CPU as NTP client.

Table 5-3
No. Instruction
1. In the project navigation, select "[YOUR_PROJECT] > [YOUR_CPU] > device
configuration" and in the inspector window click on the "Properties" tab.
2. Select the PROFINET interface of the CPU and click on "Time synchronization"

(o )- Check the "Enable time synchronization via NTP server" box (9) and
confirm the prompt. Then enter the IP address of the server CPU (9) and the
required update interval (0)_

} General Ti hronizat
ime synchronization
w FROFINET interface [X1] Y
General NTP mode
Ethernet addresszg e
Tirme ;yn(.hmnl'za [ Enable time synchronimtion via NTF server
Ce=ialiined= IP addresses
» Advanced options e
. Serverl: | 192 168 .0 2
Web serveraccess
Hardware identifier Server2: |0 .0 .0 .0
» FROFINET interface [X2] Server3: |0 .0 .0 .0
» DPinterface [X3] serverd: | o o 0 0
Starup - - - o
Update interval: |86400 s
Cycle

Reading out the system time

The system time can be read out with the instruction RD_SYS_T. The output
parameter 'RET_VAL' of the instruction corresponds to '0'" if read-out is completed
successfully.

The time is written to a variable of the Date_and_Time (DT) type via the 'OUT'
output parameter.

Calculating the local time

As the S7-300 and S7-400 CPUs do not automatically provide the local time in
addition to the system time, the system time can be converted into the local time
with the instruction BT _LT.

It might be reasonable to use the calculated local time also for the creation of
messages etc.

The following table shows the calling of the BT_LT instruction in the FBD for the
calculation of the current local time. The use of the instruction is also described in
the FAQ under \9\.

The screenshots originate from the provided sample project.

S7_CPU_SNTPServer
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5.3 Setting up an S7-300/S7-400 as NTP client

Table 5-4
No Instruction
1. Add a data block of the "WS_RULES" type to your user program.

Add new block

Mame:
WS_DAT |

Type: 1E| WS_RULES -

% Language: |Z=E |'|

Set the default values of the data block dependent on your time zone. When
inserting the data block into STEP 7 V12, the default values are preset to CET with
daylight savings time changeover. For more help on the values, please refer to the

STEP 7 help.

~ B2L  Struct 0.0 =] Base time <= Local time

= 5 Int 00 2 ] Offset base time = local time [30 min] in wint..
= T Int iy 2 @ Difference surmer to winter time [30 min], v...
~ W25 Struct 4.0 @ Switch from winter to summer

= M Byte 00 =] Manth

= W Byte 1.0 [ Occurence (1=first, 2=second.., 9 =last)

= D Byte 20 @ Day of Week (Sunday=1)

= H Bye 3.0 ™} Hour

~ S2W  Struct 8.0 =] Switch from summer to winter

= M Bye 0.0 [ Month

= W Byte 1.0 @ Occurence (1=first, 2=second,., 9 =last)

= D Byte 20 1 E Day of Week (Sunday= 1)

. H . 30 B#16#: )] [Hour

Then first read out the system time with the RD_SYS_T block.

Call the BT_LT instruction and transfer the current system time as well as the data
block created in steps 1 + 2.

The instruction returns the local time. Save this time in such a way that it can be
accessed CPU-wide. Thus, diagnostic messages etc. can be supplied with the local
time as time stamp.

RD SYS T
Date_And_Time
RET_VAL #ret
OUT — #sys_T BTLT
- — EN ENO EN
#sys_T BT Ret_Val #ret
%WDB1 LT #loc T
"WS_DAT" — Ws_DAT ENO —
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5.4 Setting up Windows PCs as NTP clients

54 Setting up Windows PCs as NTP clients

Windows XP
The following table describes the procedure for setting up a PC as NTP client
under Windows XP.
Table 5-5

No Instruction

1. Go to "Start > run" and enter "services.msc" in the dialog window. Confirm with OK.
A "Services" window opens.

2. Select the "Windows Time" service and start the service via the blue link if it has not
started yet.

Additionally set the service to "Automatic" so that it is started automatically by the
operating system upon each ramp-up.
%y Services (Local) ., Services (Local)
Windows Time MName Description Status
I ) %Webclient Enables Wi...  Starked
Startkhe service %Windows Audio Manages a... Started
%Windows Cardspace  Securelv e...
Description: %Windows FirewallfI... Providesn... Started
IMaintains date and time synchronization %Windows Image Ac... Provides im...
on all clients and servers in the network. . )
1F this service is stopped, date and time By windows Installer Adds, modi...
synchronization will be unavailable, IF this %Windows Managem.., Providesa... Started
service is disabled, any services that %Windows Managem... Providess...
explicithy depend on it will Fail bo start, %Windows Presentat... Optimizes ...
%Windows Time Maintains d...

3. Go to "Start > run" and enter "regedit" in the dialog window. Confirm with OK.
Navigate to the
"HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\W32Time\Parameter
s" folder and set the "NtpServer" key to the following value:
"[IP_ADRESSE_DER_SERVER_CPU],0x7B".

Edit String
Walue name:
MNtpServer
Walue data:
[192.16
Then edit the
"HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\W32Time\TimeProvi
ders\NtpClient\Enabled" key and set it to the value 1.
Edit DWORD Value 3
Walue name;
Enahbled
Walue data: Base
(%) Hexadecimal
() Decimal
I ak l [ Cancel l
5. Go to "Start > run" and enter "cmd" in the dialog window. Confirm with OK.
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5.4 Setting up Windows PCs as NTP clients

No

Instruction

Enter the command "w32tm /confg /update” in the command line and confirm with
Return. Windows thus refreshes the settings.

C:AWINDOWS\system32\cmd. exe

Microsoft Windows BP [Uersion 5.1.26801
C(C» Copyright 1785-2881 Microsoft Corp.

C=“Documents and Settings“Administrator>uwiZtm sconfig ~update
The command completed successfully.

Now enter the command "w32tm /resync" and confirm with Return. Thus, the time is
requested via NTP from the server entered in step 3 for the first time.

\WINDOWS\system 3 2\cmd. exe

uments and Settings“Administrat tm sresync

Sending resync command to local compu .
The command completed successfully.

Note Make sure that port 123 is opened in the firewall of your PC.

Windows 7

The following table describes the procedure for setting up a PC as NTP client
under Windows 7.

Table 5-6
No Instruction
1. | Go to "Start" and enter "services.msc" in the search line. Confirm with Return.
A "Services" window opens.
2. Select the "Windows Time" service and start the service via the blue link if it has not
started yet.
Additionally set the service to "Automatic" so that it is started automatically by the
operating system upon each ramp-up.
. Services (Local) . Services (Local)
Windows Time Name Description Status Startup Type
. : Windows Font Ca... Optimizes p... Manual
he service i Windows Image A... Provides im... Manual
“: Windows Installer  Adds, medi... Manual
Description: i Windows Live ID 5... Enables Win... Started Automatic
Mainr::ains d:te and t‘lrlﬂel s and . Windows Manage... Providesac.. Started Automatic
synchronization on all clients an . .
cervers in the network. If this service Windows Media C... Windows M... Manual
is stopped, date and time i Windows Media C... Starts and st... Manual
synchronization will be unavailable, If Windows Media P... Shares Win... Manual
::Istservll.cgtisddlsabledd, an{*_:’r}l‘ii . Windows Module... Enables inst... Manual
st:mEXpICI ¥ depend on twillaitto Windows Presenta... Optimizes p... Manual
- Windows Remote ... Windows R... Manual
. Windows Search Provides co... Started Automatic (D...
*3\Windows Time Maintains d... Manual
. Windows Update Enables the ... Autematic (D...
3. Go to "Start" and enter "regedit" in the search line. Confirm with Return.
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5.4 Setting up Windows PCs as NTP clients

No

Instruction

Navigate to the
"HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\W32Time\Paramet
ers" folder and set the "NtpServer" key to the following value:
"[IP_ADRESSE_DER_SERVER_CPU],0x7B".

Edit String [

Value name:

MtpServer

Value data:

[ DK l| Cancel |

=

Then edit the
"HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\W32Time\TimePro
viders\NtpClient\Enabled" key and set it to the value 1.

7]

Edit DWORD (32-bit) Value ==
Value name:
Enabled
Value data: Base
@ Hexadecimal
Decimal
[ 0K ] | Cancel |

w S

Go to "Start" and enter "cmd" in the search line. Execute the command line with

administrator rights. Confirm with "Yes".
r

Programs (1)

B3 crpel
D Open
ocum -
#)  Run as administrator

e 5e Pin to Tasl
Pin to 5ta

Restore previous versions

Send to 3

Enter the command "w32tm /confg /update" in the command line and confirm with
Return. Windows thus refreshes the settings.

BN Administrator: C\Windows\System32\cmd.exe

Microsoft Windows [Uersion 6.1.76H81
Copyright <{c> 208? Microsoft Corporation. All rights reserved.

C:sWindowsssystem32>w3d2tm sconfig ~supdate
The command completed successfully.

Now enter the command "w32tm /resync" and confirm with Return. Thus, the time is
requested via NTP from the server entered in step 3 for the first time.

BN Administrator: C\Windows\System32\cmd.exe

C:sWindowsssystem32>u32tm Sresync
Lending resync command to local computer

The command conmpleted successfully.

Note Make sure that port 123 is opened in the firewall of your PC.
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5.5 Setting up HMI panels as NTP clients

5.5 Setting up HMI panels as NTP clients

The following table describes the procedure for setting up an HMI panel as NTP
client.

Table 5-7

No. Instruction

Open the "Control Panel".

Open the "Profinet" dialog with the "PROFINET 10" icon. Go to the "NTP" tab.

3. Activate "Automatically synchronize with a time server" and enter an update rate.

Profinet m
‘ Profinet. | MNTP

Automatically synchronize with a time server
Update rate:|5 seC

Server 1:
Server 2:
Server 3:

Server 4:

Then click on "Configure".

4. Enter the IP address of the server CPU under "Name". In our example this is
192.168.0.2 for the S7-1500.

With a click on "Test" the availability of the server is tested.
Time Server Configuration m

Server 2

Name: I

Address: I

MTP Status!

DateTime: I

5. Confirm the entries with OK.
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\9\ FAQ: "How can you calculate the http://support.automation.siemens.com/WW/view
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\10\ | Windows Time Service Tools and http://technet.microsoft.com/pt-
Settings pt/library/cc773263(v=ws.10).aspx
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